
StreetSmart Help Index
Help screens are available for the following topics:

Overview of Operation
Definitions

Menu Commands
Icons

Using the Keyboard
Using the Mouse
Modem Usage in StreetSmart



StreetSmart Overview
The main screen of StreetSmart has three general areas:
 - the menu bar (pull-down menus)
 - the icon bar (quick icons)
 - the working area (where StreetSmart data views and dialogs appears)

The Quick Icons provide shortcuts to the most frequently used StreetSmart commands.    Equivalent commands 
are also available on the pull-down menus.

StreetSmart displays information in   views  , customizable screen and printer reports.    Depending on the view 
selected, you may look at transactions, positions, unrealized gain/losses, etc.    The Views pull-down menu shows all 
of the available views.    Views also allow you to enter transactions and positions manually.

The on-line Help system (available by clicking on the Help button on selected screens or by choosing the command 
Help Index from the Help pull-down menu) provides detailed instructions about StreetSmart functions.

Unlike other communications programs, StreetSmart dials the Schwab computer only when data exchange is 
required.    When using StreetSmart, modem connections will be made automatically as required.
Schwab provides several research resources including:    Dow Jones News, MarketScope and Company Reports.    
Consult the Pricing Guide for information about the charges for using these systems.    These facilities are available 
from the Research menu.



StreetSmart Menu Commands

File
Edit
Schwab
Research
Quotes
Views
Format
Setup
Window



StreetSmart Icons

Trading

Positions

Transactions

Securities

Graphs

Quotes

Customize

Print

Status

Disconnect



Using the Keyboard
Following the Windows convention, all of the commands in StreetSmart can be invoked from the keyboard as well 
as via the mouse.    For all menu and command choices that have keyboard alternates, a letter is underlined or 
highlighted on your screen.    To invoke that option from the keyboard, hold down the ALT key and press the 
highlighted letter.

For example, to access the Schwab menu, note that the S of the word Schwab on the menu bar is underlined.    Hold 
down the ALT key and press S and the Schwab menu will drop down.
Note again that the T of the word Trading is underlined.    To invoke the Trading command press ALT and T and the 
Trading screen will appear.    

Keyboard shortcuts are available for every command in StreetSmart and can be used by experienced users to speed 
up repetitive StreetSmart command sequences.



Using the Mouse
Mouse usage in StreetSmart follows the standard Windows conventions.      For more information, consult your 
Windows manual.



Modem Usage in StreetSmart
StreetSmart uses your modem to connect to Schwab or the various information services as needed.    While most of 
your work will not require an ongoing connection, StreetSmart will dial the Schwab computer as needed during your
working session.    

The process of getting updated balances, for example, requires access to Schwab.    Once requested, it takes 
approximately one minute and, while it is processing, you can see the progress of the call by clicking on the Status 
icon.    A window will appear and you can watch the status messages changing as StreetSmart dials, connects, 
transmits data and disconnects.

About Connecting to Schwab
When a connection is required to send or retrieve data, StreetSmart automatically uses your modem to call Schwab 
and carry out the required exchange of data.

When the modem connection is no longer needed or there has been no activity for some time, StreetSmart will 
automatically disconnect from Schwab.    In the case of an account balance inquiry, after getting the new balances, 
the modem connection is ended immediately.    For other functions, the connection will remain in effect as long as it 
is actively required.

You may be accustomed to communication programs that maintain a connection for prolonged periods of time.    
However, StreetSmart does not need continuous access to Schwab.    When connections are made only as needed, the
Schwab computer can be shared more effectively giving faster response time to users.    Also, connecting only as 
needed ensures that the phone line used by the modem is not kept busy for prolonged periods of time.



Standard Definitions
These definitions are used throughout this manual to describe terminology and labels that are found in StreetSmart.

View Fields
account To use StreetSmart, you will be assigned a Master Account

number which allows you to access the Schwab computer 
online; in addition to this master number, you can enter 
any account you choose to keep records on (including non-
Schwab accounts).    For Schwab accounts, only use the 
eight-digit number and note that it is a Schwab account on 
the Account Setup screen.    Only Schwab accounts can 
access the online features of StreetSmart (e.g. trading, 
quotes, download).

Throughout StreetSmart, the account name is displayed, 
although the corresponding account number is actually 
used to communicate with the Schwab host computer.

security name The full name of a security you have entered into 
StreetSmart; for example, Coca-Cola Company is the 
security name for symbol KO.    If no name is specified, 
the security's symbol will be displayed.

security type StreetSmart classifies securities according to the following 
list:

Stock
Bond
Option
Mutual Fund
Stock - Common
Stock - Preferred
Bond - Corporate
Bond - Government
Bond - Municipal
Bond - Zero Coupon
GNMA
Cash
Treasury Note
Treasury Bill
Unit Investment Trust
Other

symbol The trading symbol used to designate a security traded in 
the securities markets; for example the trading symbol for 
Apple Computer common stock is AAPL.

price the price per share to trade a security; for mutual funds, 
price would be the net asset value (NAV); on short sales, 
item price refers to the price at the time your short 
transaction went into effect.

quantity number of securities purchased or sold; for stocks and 
mutual funds, quantity refers to shares; for options 
quantities are contracts; for fixed income securities 
quantity is number of bonds or notes.

portfolio user-defined group of securities; can be used to group 
securities for display; may include securities that are being 



tracked for information (not current holdings).
position security holdings in an account or portfolio.
view report layout; default views are provided, user can define 

views to suit investment objectives.
pricing obtaining last trade or closing prices for securities from 

Schwab or from Dow Jones.
quotes obtaining current bid and ask prices from Schwab's real-

time trading system; users can obtain basic or extended 
quotes.

Taxable Status allows you to indicate whether the security you have 
entered is taxable in terms of capital gains, dividends or 
interest payments.

Basic Quotes Definitions
bid Price you could expect to sell for.
ask price you could expect to buy for.
size number of shares offered at bid and ask, in 100 share lots 

for stock or the actual number for bonds and options 
contracts.

date - time date and time the bid or ask last changed.
exchange the exchange where the last trade, bid or ask occurred:

N New York
A American
P Pacific Coast
X Philadelphia
M Midwest
B Boston
T OTC

tick indicates if the last trade was on an uptick or downtick; 
this appears as a + or - in front of the last trade.

last trade price at which the last trade was executed; after market 
close, this is the closing price.

open the price at which the stock opened.
high highest execution price of a trade that day.
low lowest execution price of a trade that day.
volume number of shares traded that day.
net change amount and direction the price changed since the previous 

close.
last trade date and time date and time the security last traded.
option open interest number of contracts open for the quoted option series.
activity line additional information

Extended Quotes Definitions

dividend amount Dollar value of last quarterly dividend or for splits, the 
number of shares an investor will receive for each share 
owned.

percent stock split split ratio, expressed as a percentage.
X date date a split or dividend is reflected in the price of the stock

(if you buy a stock on the x-dividend date, you will not be 
entitled to the divident); for splits this is the trading day 
after the distribution is made.



record date you must be the owner of record on this date to be entitled 
to the split or dividend.

pay date date the split or dividend is sent to the stock owners.
yield percent four times the quarterly dividend divided by the stock 

price times one hundred.
price/earnings ratio price divided by earnings per share.
earnings per share four times the last quarter's earnings divided by the 

number of shares outstanding.
earnings per share date date of the last earnings announcement.
52-week high and low highest and lowest price in the last year.

Miscellaneous Definitions
Net Asset Value Market value of one share of a mutual fund; NAV is only 

calculated once each day after market close.
Stock Dividend dividend paid to common stockholders which is in the 

form of additional shares of the stock rather than a cash 
payment.

Nominal Rate also known as Nominal Yield, this figure represents the 
percentage of annual interest which would be earned from 
a fixed income investment (i.e. bonds) if the security was 
purchased at par value; actual rate of return is usually 
different from the nominal rate listed on fixed income 
securities.

Free Credit Balance credit balance established for margin traders based on the 
amount of liquid and marginable assets in their account; 
drawing on this balance for investing or other purposes 
will reduce your Equity Percentage and is subject to 
interest charges.

Split Ratio number of shares you will receive for each share of a 
security you have a position in.    For example, a 2-for-1 
split means that you will receive two shares for each share 
you currently hold, thus doubling the number of shares in 
your possession..

Record Date the date on which you must be a shareholder of record to 
receive a declared dividend or be entitled to participate in a
stock split.



The File Menu
The file menu consists of the following commands:

New
Open
Export
Import
Equalizer Converter

Online Status
Teledistribution Update

Print
Print Setup
Exit



The Edit Menu
 The Edit menu consists of the following commands, standard Windows commands that manage the 
clipboard.    They are used primarily when collecting information from the online research 
services such as Dow Jones News.

Cut
Copy
Paste

Select All
Unselect All



The Schwab Menu
This menu provides functions that require connections to Schwab:    trading and reviewing orders, receiving mail 
from Schwab, retrieving account balances and downloading account position and transaction information.

The Schwab menu consists of the following commands:

Trading
Order Status

Mail Box
Account Balances

Transaction Download
Positions Download



The Research Menu

The Research menu consists of the following commands: 

Dow Jones News
Dow Jones News/Retrieval
MarketScope
Company Reports



The Quotes Menu
 
The Quotes menu allows you to request    Quick Quotes from the Schwab host computer. 



The Views Menu
This menu allows you to display and customize views.    The Views menu provides the following options:

Positions
Transactions
Schedule D (Realized G/L)

Securities
Price Histories

Graphs

These functions are available from the icon bar as well.

Overview
Each view works in a similar fashion.    When you select a type of view, StreetSmart displays a small window which 
lists the available views and allows you to display, edit, delete or create new views.

Standard views, defined by the system, are indicated by brackets.    Default views cannot be deleted or changed 
unless the account to which they relate is also deleted.    Each type of view has a view called [All] which displays all 
fields for all securities that have been entered into StreetSmart.

Select a specific view by clicking on it.
Display display the selected view
New create a new view definition
Delete delete the currently selected view
Copy duplicate the currently selected view; you will be prompted to 

enter a name for the copy:

and the view will be duplicated

The Customize Icon
To customize a view, first display it on the screen.    Then choose the Customize icon    (or the Customize command 
from the Format menu) to adjust the view.    Each type of view has different parameters.



The Format Menu
The Format menu provides the following commands

Customize
Font
Page Setup

Save View
Save As View
Rename View



The Setup Menu
The Setup menu provides the following commands:

Account
Category

Network
Modem
Preferences



The Window Menu
The Window menu provides the following commands

Cascade
Tile

Arrange Icons
Close
Close All



Trading
Trading with StreetSmart is a two-step process:
1.    Prepare the order(s)
2.    Submit order(s) to Schwab
Orders can be prepared and retained in StreetSmart for later submission.    Single orders can be submitted or multiple
orders can be submitted in a batch.
After selecting the Trading command, the first screen displays data pertaining to unsubmitted orders:

Standard fields (Symbol, Price, etc.) are defined in the Definitions section of the manual.
Action transaction type requested (buy, sell, sell short, etc.)
Time Limit one of four conditions which relate to the amount of time you 

choose to leave an unfilled order open:
 Day Only

Good Till Cancelled (good for up to 60 days)
Fill or Kill
Immediate or Cancel

Add Order
To set up a new order, click on the Add Order button on the Trading window.

Standard fields (Symbol, Price, etc.) are defined in the Definitions section of the manual.

Action the transaction type requested (e.g. buy, sell, sell short, etc.)
Price price to bid for the specified security

You can choose to trade at the market price or set limits for the price you want to trade at. 
When Limit, Stop or Stop Limit are chosen, the white boxes are activated and labelled so 
that you can type in the required amount.    For example, choosing Stop    causes the 
following change to the display:
Market - listed price at which a security is being traded at the time an exchange or other 
trading venue receives your order; orders placed "at market price" are generally filled 
immediately

Limit Price - price at which you want to have an order executed
Limit Order - order instructing your broker to execute a trade at a specific price (or 
better); buy orders are executed at or below your limit price, sell orders occur at or 
above the limit price

Stop Price - security price at which a Stop Order is intiated
Stop Order - security order that becomes a market order once the security has traded at 
your designated Stop Price

Stop Limit Order - order which becomes a Limit Order once the security trades at your 
designated Stop Price

Time Limit select the time limit during which the order can be executed

Day Only - order which is automatically cancelled after the close of the trading day if 
the order is unfilled; day orders placed after the close of trading will be open until the 
close of the next market day

Good Till Cancelled (GTC) - order which will remain open until executed or cancelled; 
GTC orders are automatically cancelled by Schwab after 60 days

Fill or Kill (FOK) - order to execute a trade immediately or cancel the request; these 
orders are usually placed when a customer is placing a large trade which, if filled, would
noticeably affect the market price for the security; FOK orders are never partially filled

Immediate or Cancel (IOC) - order which requires that all or part of the specified number 
of shares be executed immediately; if any portion of the order is not filled, it will be 
automatically cancelled; IOC orders are usually placed for large trades



Special Conditions
When selected, this option places other conditions on the order:

All or None (AON) - an instruction to execute a trade only if all of the specified shares 
can be transacted; the entire order is cancelled if it can only be partially filled

Minimum quantity - minimum number of shares you want to execute in a given day; 
minimum must be at least 200 shares and the order must total 300 or more shares

Do not reduce (DNR) - instruction to the broker not to reduce the price on your Buy 
Limit or Sell Stop orders to reflect the dividend on the ex-dividend date; you must 
specify Good Till Cancelled in the Time Limit field when placing a DNR order

Finally, the values in the bottom right corner of the window will be filled in upon completing your instructions; if 
quote data is available, the projected value of the order will be estimated from the most recent quote.

This process creates an order.    The order must be submitted to Schwab by a separate action. With StreetSmart, you
can create and store multiple orders until you are ready to submit them.    Orders can be submitted individually or as 
a batch if you choose.

Submit Selected Orders
Once you have created your order(s), go to the Unsubmitted Orders screen and select all orders to be submitted by 
holding down the Ctrl key and clicking on them.    Each order selected will be highlighted.    Then submit the 
order(s) to Schwab by clicking on the Submit Selected Orders button.

After your order is executed, a record will be available through the Transaction Download command on the Schwab 
menu.

Edit Order
Once an order has been created but not yet submitted (i.e. is on the Unsubmitted Orders screen), you can change it 
by selecting the Edit Order button on the main Trading window.    The screen that appears is similar to the Add 
Order screen:

Make the desired changes and select OK to return to the previous window.    (The fields are defined under the section
that describes the Add Order command).    Note that the changes have been incorporated into the order on the 
screen.

Delete Order
When you wish to delete an unsubmitted order, highlight the order by Ctrl clicking on it.    The Delete Order button 
will remove the order.    You will be prompted to confirm that the order should be deleted.

Note that this procedure does not work if an order has already been submitted to Schwab.    To cancel submitted 
orders, use the Order Status command on the Schwab menu, described below.



Positions View
Position views display information about securities that you hold a position in.    You can specify what securities or 
categories of securities, or accounts are to be displayed as well as how to sort and subtotal the securities and which 
columns to display.

Position views can be customized by specifying the following fields:

As of Specifying 
now 

for this field requests a view as of the current date; otherwise, 
specify the required date.

Filter by the account(s), securities, types of securities and categories to 
display on the view (other items will be filtered out)

Subtotal by subtotal by symbol, by category, etc.
Sort by display items in the order specified
Show Columns select the columns to be displayed on the view by clicking in the 

checkbox to enable/disable specific columns
Purchase Date date security was purchased
Commission fee charged by a brokerage firm to place security trades
Total Price total cost of transaction calculated as (quantity*item price) + misc 

fees + commission
Current Price security price as of the last time you updated prices for this security
Market Value Quantity * Current Price.    Since current price represents the price 

when you last accessed the Schwab computer, the market value on 
your Position Views screen may not accurately reflect the actual 
market value for trading

Unrealized 
Gain/Loss $

calculation of the dollar value you have gained or lost on a security 
position which is still open; upon selling or closing the security 
position, this gain or loss would be come realized rather than a paper
gain/loss

Unrealized % 
Gain/Loss

calculation of the annualized % return on a security investment for a 
position which is still open; upon selling or closing the security 
position, this gain or loss would become realized rather than a paper 
gain/loss

Unrealized 
Annualized % 
Gain/Loss

Adjusting data calculations such as rate of return and gain/loss so 
that the result is equivalent to looking at a security as though it had 
been held for exactly one or more years

Current Yield actual rate of return on a fixed income security (i.e. bond or note) if 
it were purchased today; this figure generally fluctuates with interest 
rates in the economy and will typically be different from the rate of 
return stated on the security (i.e. nominal rate)

YTD Dividend the sum of all cash dividends paid since the start of the calenday year
YTD Interest the sum of all interest payments you have received since the start of 

the calendar year
Holding Period length of time an asset has been owned by you;    this is most often 

used to determine short-term vs. long-term gains and losses



Transactions View
Transaction views display transactions.    In addition, you can manually add new transactions, edit existing 
transactions or delete old transactions from this screen.    Transaction views can be customized to display 
transactions from a specified range of dates, sorted in whatever fashion is required.

Transaction views can be customized in the following way:

From/To the start/end date of the view
Filter the account(s), securities, types of securities and categories to 

display on the view (other items will be filtered out)
Sort by display items in the order specified
Misc Fees any non-commission charges associated with the transaction (e.g. 

transfer fees, dividend reinvestment fees, etc.)
Commission fee charged by a brokerage firm to place security trades
Settlement 
Date

actual settlement of a transaction takes one to five days after the 
execution of a trade; the settlement date can be verified by reviewing
your confirmation notice sent by the broker

Accrued 
Interest

interest on a bond or other fixed income instrument that has 
accumulated since the most recent interest payment was made; when
a security with accrued interest is sold, the buyer pays the seller the 
security's price plus the accrued interest

Description blank field for user to make notes about the transaction



Securities View
Security views display securities and information about them.    From the Securities View screens, you can add new 
security definitions, edit existing security definitions and delete securities.    (Note that you cannot delete a security if
there are transactions for that security.)

On this screen, there are two places below where you can select High Alert and Low Alert.    Choosing High Alert or 
Low Alert as a filter means that your view will display only the securities that have high a high or low price 
respectively.    Choosing High Alert or Low Alert as one of the columns to show means that when the requested 
securities are viewed, there will be a column that indicates whether or not that security has hit a high or low price.    
The definition of a high and low price is specified when you define the security (and can be changed by the Edit 
button from the Security View).

High highest price the security has traded at during the current or most 
recent trading day

Low lowest price the security has traded at during the current or most 
recent trading day

Volume number of shares that have traded as of the opening of today's 
market activity

52 Week High highest price per share that the security has traded at in the past 52
weeks

52 Week Low lowest price per share that the security has traded at in the past 52 
weeks

High Alert notify if a security's per share price meets or rises above a level 
specified by you

Low Alert notify if a security's per share price meets or drops below a level 
specified by you

Last Trade security price at which the last trade was executed; after market 
close, this is the closing price

Last Quote 
Update

date when you last received a quote on this security

Quote Source which source was used to receive your last quote:    Schwab, Dow 
Jones, manual entry, etc.

Retention 
Frequency

number of quotes you want to retain on a specific security; for 
example, specifying everything means that your database will 
retain every quote you request for the security; specifying once 
per week means that only the last quote you request each week 
will be saved

Retention 
Period

length of time you want to retain historical quotes in your 
database; for example, you have the flexibility to save from as 
little as one day of data to all the quote data you have ever 
requested

Retention 
Months

number of months you want to retain the historical quote data you 
have stored in your database

Expiration 
Date

(options only) options which have expired cannot be exercised 
and no longer have any market value

Maturity Date date on which the final interest payment and original pricincipal 
invested in a fixed income security (i.e. bond or note) is due and 
payable by the debt issuer

Yield to 
Maturity

rate of return an investor can expect to receive on a fixed income 
security (i.e. bond or note) if the security is held until its specified 
maturity date

Dividend dividend distributions (generally representing a percentage of the 
company's earnings)

Taxable Status whether security is taxable in terms of capital gains, dividends or 



interest payments
CUSIP # Committee on Uniform Securities Identification Procedures 

identification number assigned to each security
SIC Standard Industrial Classification (SIC) code assigned to the 

company identifying the company's primary industry; this code 
may be used as a general way of tracking industry performance or 
to compare performance within an industry

Last Split Date date on which a stock last split its shares or paid a stock dividend



Graphs View
Graph views allow you to display your data as graphs rather than tables of numbers.    The graphs provide a visual 
display of the most commonly used securities graphs:    gain/loss, ROI, price history and asset allocation.

The following fields are available to customize graph views:

Price History line graph which plots historical price and volume 
movemements of the security you indicate; price data used to 
create these graphs can be imported, manually entered or taken
from quotes that you requested and saved

Asset Allocation pie chart or bar chart of breakdown (by category) of your 
assets; for account(s), position view(s) or category(s)

Unrealized 
Gain/Loss

paper gains/losses of securities, accounts, position views and 
categories for any time period

Realized 
Gain/Loss

realized gains/losses of securities, accounts, position views, 
and categories for any time period

Return on 
Investment (ROI)

performance of securities, accounts, position views and 
categories with regard to the percentage of return obtained 
from your investments



Quick Quotes
This command gets price quotes on a security or group of securities.    It is equivalent to using the Quotes icon.    The
initial screen shows quotes that have already been requested during the current session.    In addition, the buttons 
across the top of the screen allow you to request a quote or display additional data for the currently highlighted 
quote.

Market indicators (DJ Industrial Average, NYSE Volume, tick) on the top right of the screen will be inactive (grayed
out) if the information is not available.
Standard fields are defined in the Terminology section of the Reference manual.

Volume number of shares that have traded as of the opening of today's 
market

Net Change amount that the security's price has increased or decreased as of the 
previous market close

Flags indicators of special situations affecting trading, volatility, price, etc. 
for the requested security; examples of quote flags include security 
split announcements, trading halted, and ex-dividend date

More
The More button displays additional fields that relate to the currently highlighted quote.

Get Quotes
The Get Quotes button initiates a connection to the Schwab host computer and retrieves the quote information that 
was specified from the Select Symbols screen.    From this screen, select a view, security or securities as well as 
market indicator(s) to be quoted.

Each selected item counts as one quote and is deducted from your Quote Bank Balance (as shown on the Account 
Balances screen).

Security Views
This selection allows you to choose a security view(s) to be priced.    Note that this is a multiple selection box and 
you can select as many views as you wish to price.

Position Views
This selection allows you to choose a position view(s) to be priced.    Note that this is a multiple selection box and 
you can select as many views as you wish to price.

Price Through
Consult the Pricing Guide for the cost of the quote services listed below.    

Dow Jones pricing delayed by 15 minutes; quotes obtained through Dow Jones 
do not retrieve Net Change or flag data

Schwab real-time quotes during market hours; real-time quotes are free if you
have a Quote Bank balance available

Quote Type
Basic quotes provide complete security quote plus volume and market information
Extended 
quotes

basic quote, volume and market information plus additional data on 
dividends, stock splits, p/e ratio, earnings per share, 52-week high 
and low



Add new Security
adds the entered security to the securities list for present and future quotes; once the security has been 
added to StreetSmart, the symbol and security name will appear on the pull-down menu of every screen that
has these fields



Customize
The Customize icon / command allows users to change the format of the currently displayed view.    The fields and 
customization permitted vary depending on the type of view.

See also:    Securities View, Transactions View, Positions View, Graphs View, Pricing View



Print
StreetSmart uses the standard Windows printing dialog to print the currently active window.    For more information, 
consult your Windows documentation.



Modem Status
This command displays modem status (connected, disconnected, messages).



Disconnect
The Disconnect command hangs up on the current modem connection.    This command is accessed either through 
the Disconnect icon or by selecting Disconnect from the File menu.



New Command
This command creates a new set of StreetSmart database files.    This is useful if you are managing two master 
accounts and wish to keep them completely separate.    If, for example, you are managing an additional account and 
want to later transfer the files to someone else, you may want to have the data in separate databases so that you can 
provide only the data that relates to that account.    It is not necessary to create a new set of databases if you will 
simply be managing multiple accounts on an ongoing basis (e.g. your personal account, retirement account, 
college savings fund, etc.).

The first screen confirms that you wish to create the files.    Click on OK to proceed.

After you click on OK, you will be prompted for the directory where the new databases will be stored:

Finally, the files will be created.    When you wish to use the files in these new databases, you must use the Open 
command to specify that the new files should become active.



Open Command
This command closes the current StreetSmart database files and opens a new set of files.    You will be prompted for 
the location of the new files and these new files will then become active.    Before you can open a new set of 
databases, you must create them with the New command.



Export Command
This command stores transactions in a file that can be used outside StreetSmart.    There are several formats 
available:

 - StreetSmart format - used to export data to a newer version of StreetSmart
 - ASCII comma delimited or tab delimited - used to export to a database or other program
 - Lotus 1-2-3 - used to export to many spreadsheet programs
 - Tax Exchange Format - for income tax programs (e.g. TurboTax)
 - Quicken    - for the account package Quicken

When using the StreetSmart (.SAC) format, all of the current StreetSmart data is exported.    When using other 
formats, only the data in the currently displayed view will be exported.

Exporting to Quicken
The QIF format can only be used by Quicken.    Quicken needs to see each of the transactions as either an 
Investment or a Bank Transaction.    For this reason, you will be prompted to choose which of these will be exported.
In order to transfer all the data in the Transaction View, it will be necessary to do two exports:    one where you 
choose to export the investments and one where you choose to export bank transactions.    It will then be necessary 
to set up two different accounts in Quicken to receive this data.

Exporting to TurboTax
The TXF format is intended for TurboTax to track Schedule D activity and import it into TurboTax.    This option is 
only available from the Schedule D view.

Exporting to Spreadsheets
The WKS format which is native to Lotus 1-2-3 can also be imported by many other spreadsheets including 
Microsoft Excel and Borland's QuattroPro.    

Exporting ASCII Text
The TXT format can be read by almost any program and will be used primarily for exporting Dow Jones News, 
Company Reports, mail or MarketScope text.    Note that when exporting ASCII text, the fields that will receive the 
text must be large enough.    For example, importing text to dBASE may be problematic if the text fields are longer 
than the allotted dBASE fields.    In addition, some data may contain commas within the data which interfere with 
the import of comma-separated text.    For example, the description field may contain commas which cause difficulty
with data import to programs such as Paradox and dBASE.    For importing to Paradox, we recommend tab-delimited
ASCII files.



Import Command
This command retrieves transaction data from another program.    When initializing a new version of StreetSmart, 
the Import command can be used to import the data that was exported from the previous version of the software.



Equalizer Converter
This command retrieves data from the Equalizer, Schwab's DOS-based portfolio management system.

After the command is selected, StreetSmart searches for a directory containing Equalizer files.    Once detected, you 
will be asked to confirm that location.    The files will then be converted to StreetSmart and added to the currently 
open data files.



Teledistribution Update
This command downloads a copy of the newest version of the StreetSmart software from Schwab.



Print Setup command
This command invokes the standard Windows printer selection and setup dialog.

From this screen, select the printer to be used to print, the paper format and set printer options.    The Options button 
causes a new window to appear which can be used to specify the printer options.    The available options will 
depend on the printer available and its features.    



Exit command
This command ends your StreetSmart session.    It is important to exit StreetSmart either by using this command or 
clicking the close box in the upper left corner of the StreetSmart window to ensure that StreetSmart ends normally 
and updates all files before stopping.

If you do not exit properly, your StreetSmart records may not be saved correctly and data may be lost.



Cut
This command deletes the currently selected item(s) and automatically puts a copy into the Windows clipboard.    
Note that using the Cut command will erase the previous contents of the clipboard.    Use the Del key to delete 
material without affecting the clipboard.



Copy
This command copies the currently selected item(s) to the Windows clipboard, without deleting the selected material
from its current position.    The previous contents of the clipboard will be lost.



Paste
This command inserts the contents of the clipboard at the current cursor position.    The contents of the clipboard 
will remain until replaced with another Cut or Copy command.



Select All
This command selects all selectable items in current window.



Unselect All
This command unselects all selected items in current window.



Order Status
This command allows you to view the status of open or executed orders on the Schwab host.
Standard fields (Account, Symbol, etc.)    are defined in the Definitions section of the manual.
Get Order Status dial the Schwab computer and get open order records
Show Specify which records to display:

All Orders
Open Orders only
Closed Orders only

Order Number unique Schwab identification number assigned to your order
Status REV PEND order received by Schwab but not yet accepted and

sent to an exchange
PLACED order accepted and sent to an exchange
EXECUTED order filled
CANCELLED cancelled prior to execution

Date/Time when order was placed
Condition time limit placed on order (e.g. Good Till Cancelled or Day 

Only)

Change Open Order Change the parameters of an order which was submitted but but has not completely 
executed

Cancel Open Orders Cancel an unfilled order with the Schwab computer



Mail Box
This command displays messages from Schwab regarding transactions or information about system operation.    
When StreetSmart dials into Schwab, notifications about new mail are displayed on the status line.

To read new or previous mail, make your selections from the Mailbox screen.

Download New Mail retrieve mailbox items which Schwab has sent 
you since the last time you accessed the 
StreetSmart mailbox

Download Old Mail retrieve mailbox messages from the past
Read Previous retrieve the previous mailbox item
Read Next access the next mailbox message



Account Balances
This command displays balances for all Schwab accounts and can be updated daily from the Schwab host computer 
by clicking on the Get Balances button.    Only the values that are relevant for your account will be displayed.    For 
example, if your account is not a margin account, margin values will not be displayed.

Within your Schwab account, there are various sub-accounts and balances which are itemized so you can see a great 
deal of detail on your account.    The following definitions explain what each of these fields means.

Cash on 
Deposit

liquid cash balance; depending on the type of account, this balance 
may or may not be eligible to earn interest in a money market fund

Money Funds 
Balance

liquid cash balance which is earning interest at the current applicable
money market rate

Margin 
Borrowed

amount borrowed from Schwab as cash or for the purchase of 
securities; the broker's current applicable margin interest rate will be 
charged on funds borrowed through the margin account

Total total cash balance in your Schwab account (= cash + money market 
funds - margin funds borrowed)

Cash Account 
Long

a cash account is a brokerage account in which all transactions are 
paid for and settled with cash (as opposed to margin credit); "long" 
refers to purchasing a security position; cash account long is 
therefore the market value of securities purchased and settled with 
cash

Margin 
Account

a sub-account within your Schwab account which is used for totaling
all margin activity

Margin 
Account Long

market value of securities owned and paid for through credit 
extended by the brokerage firm; investing with broker-extended 
credit is also known as borrowing on margin

Total Long 
Value

total market value for securities owned in the account; these 
securities were purchased with cash and/or credit (margin 
borrowing)

Short Account market value of securities sold short; short selling or "shorting" 
securities refers to the sale of securities which are not actually owned
by the investor

Margin 
Account Equity

value of cash and marginable securities in your margin account, 
minus any funds borrowed on margin; the    liquidation value of your 
margin account if there are no option positions in the account

Equity 
Percentage

equity in your margin account divided by the market value of the 
Margin Account Long; percentage of the margin account's current 
value you would receive if you liquidated the account and repaid any
margin borrowing; equity percentage decreases as margin borrowing 
increases

Schwab One 
Limit

amount of funds that may be withdrawn from you Schwab One 
account for check writing, security purchases and Visa privileges

Margin Cash 
Available

amount of money which can be withdrawn from your margin 
account; includes the free credit balance in your margin account plus
the maximum amount you can borrow against marginable securities

SMA special memorandum account which notes margin account's funds in 
excess of your margin requirement; these funds comprise a portion 
of your buying power and can be used for security purchases or cash 
withdrawals

Total Buying 
Power

maximum value which you can borrow on margin without being 
required to deposit more cash or equity in your margin account

Margin Call requirement of the investor to deposit sufficient cash or marginable 
securities to meet Schwab's minimum margin requirements; two 



kinds of margin calls may occur:    Federal Calls and Maintenance 
Calls

Federal Call required deposit of cash and/or marginable securities resulting from 
investment activity (i.e. the execution of an order) which has 
exceeded your buying power

Maintenance 
Call

required deposit of cash and/or marketable securities resulting from 
adverse market activity which has altered your margin account value 
and dropped your equity below the minimum margin requirements

Option 
Account

sub-account within your Schwab account that handles options 
transactions

Options Market
Value

value of all open option positions held in the options account; since 
options are not marginable, their value is not considered in 
calculating equity for margin purposes

Require 
Reserve

cash reserve required in your account to maintain open positions in 
uncovered options or spreads; as these option positions expire or are 
liquidated, the required reserve will decrease

Month to Date 
Earned

total of dividends paid (i.e. fixed stocks and mutual funds) and 
interest earned (i.e. from fixed income investments such as bonds) 
during the current month

Month to Date 
Owed

interest owed to Schwab for margin borrowing which has accrued 
since the beginning of the current month; payment is automatically 
deducted from your balance on a monthly basis

Total Account 
Value

this is the same Total Account Value displayed on your Schwab 
statement; it incorporates cash, securities (except options) and any 
miscellaneous credits/debits within your Schwab account



Transaction Download
This command downloads transactions which have occurred in your account(s) for up to the past 30 days (including 
checks, deposits, trades and other activities not generated through StreetSmart).

The data you receive from the Transaction Download command is similar to information found in your monthly 
Schwab statement.



Positions Download
The Positions Download command retrieves a summary of the security positions held in the specified Schwab 
account.

Get Positions Retrieve position data from the Schwab computer.

Add to Transactions
Convert position information to transactions.    This command is useful when you begin working 
with StreetSmart and your current positions with Schwab are not recorded in StreetSmart.    By 
selecting this command, the currently owned securities (positions) are converted to transactions so 
that StreetSmart can record that the securities have been purchased.

Additional information (i.e. purchase price, purchase date, etc.) will need to be added manually to 
the resulting transactions in order to provide useful gain/loss and Schedule D reports.



Dow Jones News

This command gets headlines and news stories from Dow Jones News®.    Once you have selected the command, 
specify the symbol of the security to research and request the desired information (as described below).

Symbol symbol of the security to research
Get Headlines clicking on this button gets headlines from the 

past 90 days for the selected security
Get Stories clicking on this button gets the stories associated

with the selected headlines; headlines can be 
selected by holding down the Ctrl key and 
clicking on them

Connect establish a connection to Dow Jones News
Disconnect after download sets StreetSmart to disconnect from Dow Jones 

immediately after downloading the requested 
information; use this selection if you wish to 
retrieve only the current set of headlines/stories; 
if you will be requesting a variety of 
information, turn this parameter off so that the 
connection to Dow Jones will be maintained 
throughout a series of requests

Download all stories since requests that all stories since the specified date 
be downloaded to StreetSmart



Dow Jones News Retrieval

This command provides access to Dow Jones News Retrieval® databases for news on stocks, mutual funds, 
earnings, insider trading, etc.

To begin, click on Connect to establish a connection.    You will then be able to select from the databases provided.    
To obtain a sampling of the services available without incurring online costs, use the

//
database.    When you have decided which databases will be helpful in your research, you can begin using those 
databases to access desired information.

Database selects the specific database to be searched
Connect connects by modem to Dow Jones News Retrieval
Capture text is on

captures all material retrieved for later printing or review



MarketScope
The S&P MarketScope research service is another online service with its own display window.    This service 
provides a variety of market, company and industry information including:

S&P analyses of stocks and industry developments
S&P recommendations for specific investment and portfolio objectives
commentary on current market activity, economic developments and volatile issues, updated throughout the day
specific S&P earnings and dividend forecasts on more than 1,000 companies.

To use MarketScope, click on the Connect button.    Then simply type the symbol of the security that is of interest.

The fields on the window are:
Symbol the first field in the upper left corner specifies the 

security symbol you are researching
Text display text pertaining to the symbol selected
Statistical display statistical data pertaining to the symbol 

selected
Get Symbol Page display a brief business description for the symbol 

selected
Exit terminate the connection to the MarketScope 

database
Get Action specifies the type of data to retrieve

Note that for some actions (e.g. Stock(s) in the News) there are multiple pages.    By default StreetSmart retrieves 
only the first page when you click on Get Action.    To retrieve the additional page(s) that are required, drag the 
elevator bar to the bottom of the screen.    There will be a cursor at the bottom of the screen that allows you to enter 
commands.    To retrieve, for example, page 7 of a report, you would type

:7
and press the Enter or Return key.

Note also that when you receive the message that the research buffer is 85% full, you should export your research to 
a file or print it to clear the data to make space for additional information.

When you have completed your research, click on Exit to end the MarketScope session.    You will be prompted 
whether you wish to disconnect.    Click on Yes to terminate the session.

 



Company Reports
This command provides detailed company profiles including descriptions of the company's current outlook, its 
valuation, profitability and growth statistics, balance sheet and income trends, earnings per share estimates and 52-
week price and volume charts.

When you select Company Reports from the Research menu, the main screen appears.

Simply enter the trading symbol for the company of interest and click on Get New Report to get a report.    If you 
need only one report, click on the Disconnect after download box so that the modem will disconnect after 
retrieving the requested report.    If you wish to request several reports, do not turn on this setting, so that you can 
retrieve multiple reports without having to wait for reconnection.



Price Histories view
Price history views show previous pricing information obtained for specific securities.

Price history views can be customized in the following way:

Securities
Date
Show Columns



Schedule D (Realized G/L)
Schedule D refers to a section of the federal income tax forms which is used for reporting capital gains and losses 
from investment activity.    While the Schedule D Views window of StreetSmart is designed to help you with 
calculating your gains and losses, it does not constitute everything you may need to know to file your tax forms 
properly.

Schedule D views can be customized by setting the parameters below.    Note that you cannot change the fields that 
are displayed because the Schedule D format is defined for tax purposes by the IRS.

Show specifies whether short term or long term securities are to be 
displayed; the definition of long term is specified in the 
Preferences  command on the Setup menu

For Period sets the start and end date
Filter indicate the account(s) to display on the view (other items will be 

filtered out)



Font 
This command selects a different font for the current view.    Fonts should be used with care since font size will 
affect the amount of data displayed in views.

Font name of the font family (e.g. Times, Helvetica)
Effects underlined or strikeout
Color black is the standard for print but you may select colors
Font Style italic    or bold
Size size of the text, in points (e.g. this text is 12-point)

When selecting a font, keep in mind that all of the fonts available in Windows will not print the same as they display
on your screen.    If you want to check that your screen font is also a printer font, choose the Control Panel icon in 
the Main group and then select the Fonts icon.    Next use the scroll box containing the font names and highlight the 
font that you wish to use.    A description of the font (describint its attributes) will appear under the listbox once you 
have highlighted the font you wish to use.    Please note that all TrueType fonts are both screen and printer fonts.

If you wish to have your screen display data in columns, you must choose a fixed font (e.g. Courier).    A fixed font 
allows the same amount of space for each character.    If you choose a proportional font (such as Times Roman or 
Helvetica), data might appear in columns with a skewed appearance.



Page Setup (Format menu)
This command selects the page setup for printing the current view.

Margins amount of white space to leave at the edges of the paper
General Preferences a title to display at the top of the page; if Date Stamp is enabled, the date will also appear

at the top of the page



Save (Format menu)
This command resaves the current view under the same name.



Save As (Format menu)
This command saves the current view under a new name.    You will be prompted to enter a new name.    Note that 
the old view is not deleted during this process.



Rename (Format menu)
This command assigns a new name to the current view.    You will be prompted for the new name.



Category setup
A category is a group of investments which are defined by the investor to suit their purposes.    For example, some 
investors may define categories by security type such as stocks, mutual funds, bonds, etc.    Other investors may 
establish categories using industry classifications such as biotechnology, transportation, textiles, etc.    The Category 
setup feature of StreetSmart gives you the flexibiility to define as many categories as you would like, breaking up 
your securities in whatever manner is most informative and meaningful to you.

This command creates a category name.    To add securities to the portfolio definition, you must use the Securities 
View screen.

Add create a new category name
Edit change an existing category name
Delete delete a category name
Close close this window and resume other operations



Setting Up Account Numbers
This command specifies all of the accounts you will monitor and/or trade in with StreetSmart.

Schwab Master Account 
Number

the number assigned by Schwab when you purchased 
StreetSmart

Add add a new account number

Edit change the name or number associated with a previous
account

Delete delete an account

Network setup

This command specifies the Schwab connection parameters which are required for 
accessing the online features of StreetSmart.    

Passwords and access phone numbers must be entered by the user.    In addition, you may 
need to change them if you move to a different city or access Schwab's computers while 
travelling.    Passwords and access numbers are provided in your StreetSmart starter kit.

Dow Jones Password this password is transmitted automatically when a connection request 
for Dow Jones News or Dow Jones News/Retrieval is made

Info Provider this is the ID and Key of the Scwhab host computer; this information is
the same for users worldwide

CompuServe Phone # the local access phone number for the Compuserve network; 
note that you can specify up to three CompuServe access numbers; 
the currently active CompuServe number is indicated by the radio 
button to the right of the number and you can switch between 
numbers by entering a new number and clicking on the radio button 
beside the new number.    To obtain your local CompuServe number, 
refer to the CompuServe network access number booklet or call 
800/848-8980.

Note that if you have Call Waiting on your modem phone line, 
you must enter a dialing prefix to disable Call Waiting for the 
duration of your connection to Schwab.

Alternate Network telecommunications carrier (e.g. Tymnet) which is to be used as an 
alternate to CompuServe; you must specify an account number and 
password for accessing this network, as well as the access phone 
number



Modem setup
This command specifies parameters for your modem.

Baud rate speed of your modem transmission (e.g. 2400 bps, etc.)
Port physical connection to your PC
Modem type of modem (e.g. Hayes )

Advanced
specify pulse or tone dialling and enter special machine-level commands to control the modem's operation



Preferences setup
This command selects user-defined operational parameters.

Require password to access StreetSmart
if a password is set in this field, StreetSmart will request a password before loading; if you have specified a 
password and later forget it, you must reinstall the StreetSmart software

Display cents for currency amounts
display currency with cents rather than fractions (the standard way)

Use fractions for stock prices
display currency values as fractions:    1/8, 1/4, etc.

Short Term Period
by default "short term" refers to one year or less; this affects the Schedule D view and has possible tax 
consequences; consult a tax advisor before changing this value



Cascade
This command specifies that windows should be overlapped in a cascade.    

Note that this command rearranges the currently open windows.    When new windows are opened, they do not 
cascade but rather appear in their usual fashion.    Issuing this command again will cascade the new window(s) with 
the old.



Tile
This command specifies that windows should not overlap but should be tiled.    Tiled windows are arranged like a 
series of tiles that do not overlap.    This option is not practical if more than two or three windows are open. 

Note that this command rearranges the currently open windows.    When new windows are opened, they do not tile 
but rather appear in their usual fashion.    Issuing this command again will tile the new window(s) with the old.



Arrange Icons
This command arranges the icons into a more orderly grid display.



Close
This command closes the currently active window within StreetSmart.    For example if you have been getting 
Quotes, that window will be closed although StreetSmart will remain active and other windows will remain open.



Close All
This command closes all currently open windows in StreetSmart (except the main working window).



Setup Account - Add 
From this screen, add accounts to the list that StreetSmart manages and maintains.

Account Name Name of the account.    This text is used by 
Schwab for identification only nand can be set to
a meaningful value for the user.    For example, if 
you have several accounts, they can be named in
a way thar is meaningful to you.

Account Number 8-digit number assigned to your account by 
Schwab.    This number is used to idwntifdy your 
account and must be correct before any account 
operations are permitted.

Schwab Account If enabled, the account will be able to use 
Schwab's full range of online services.    If 
disabled, the account information can be 
manually entered and maintained but no online 
trades will be available.



Setup Modem
This command specifies parameters for your modem.

Baud rate speed of your modem transmission (e.g. 2400 bps, etc.)
Port physical connection to your PC
Modem type of modem (e.g. Hayes )



Advanced Modem Setup

From this screen, specify pulse or tone dialing and enter special machine-level commands 
to control the modem's operation.    Modem commands should only be entered if you are an 
extremely experienced modem user or at the direction of a Schwab support representative.



Add/Edit Price History
The Add/Edit Price Histories screens allow you to add/edit price history records.    Both 
screens require that the quote date, quote time and price fields be filled in.    The other 
fields however, are optional depending on the amount of detail you choose to store.    After 
you fill in the quote data and click OK, it will be added to the other quotes displayed on the 
Price History View screen.



Preferences
This command selects user-defined operational parameters.

Require password to access StreetSmart
if a password is set in this field, StreetSmart will request a password before loading;
if you have specified a password and later forget it, you must reinstall the 
StreetSmart software

Display cents for currency amounts
display currency with cents rather than fractions (the standard way)

Use fractions for stock prices
display currency values as fractions:    1/8, 1/4, etc.

Short Term Period
by default "short term" refers to one year or less; this affects the Schedule D view 
and has possible tax consequences; consult a tax advisor before changing this value



Add Security
When you want to receive a quote or trade a security for the first time, you must add its 
symbol to the list of securities.

Type the security symbol in the Symbol field and set the correct value for the Security 
Type field at the top of the right hand column.    Entering the appropriate name in the 
Security Name field is not required, but is recommended for reporting purposes.    You 
may use the Tab key to move from one field to another, or you can simply click on the 
desired field to move the cursor there.

When you are finished entering information, click on OK to add that symbol to the list of 
securities that are available for trading and quotes.

Special Notes About Retention
When adding a security, you can specify the Retention Period and Retention Frequency.    
These parameters affect the price history data only if quotes are received through the 
Quick Quotes screen.    These settings do not affect quotes that were added manually.

Retention Period:
For Ever - all future quotes are saved; previous quotes received before this setting was 
changed are not added to the database
Given Months - all quotes before the given number of months are saved; this takes effect 
when the next quote is received through Quick Quotes.    When the next quote is received 
all quotes (whether entered manually or downloaded) that are older than the specified 
number of months are deleted.    To ensure that quotes are retained for the full period 
required, the number of months does not include the current month.    So if 2 months are 
requested, for example, on September 23 all of the data for the month of September plus 
the previous 2 months (July and August) will be retained.
Current Quote Only - no future quotes will be saved in the price history database.    
Existing quotes received before this setting was changed will remain in the database.

Retention Frequency:
Everything - all quotes will be saved based on the retention period setting; the time of the 
quote is local time, and multiple quotes in the same day will all be saved
One Per Day/Week/Month - only the last quote in the requested time period will be 
saved; this setting takes effect after receipt of the second quote in a given time.    A week is 
defined as 12:01 a.m. Monday through Sunday midnight. 



Tax Lot Matching
Tax lot matching allows you to maintain correct tracking of lots of securities for tax 
purposes.    For example if you own two lots of 100 shares of a particular company, when 
you sell one of those lots, the correct lot (with the correct purchase date and price) must be
noted in order to correctly calculate capital gains and taxes.    You should do tax lot 
matching after downloading transactions.    This screen is automatically invoked when you 
enter a manual order.

Simply select the lot(s) that constitute the securities to be sold and click OK to proceed.    
Since all securities of a given type are identical, Schwab does not need to know how you 
will be matching the lots.    This is for your own records for taxation purposes.



Network Setup
This command specifies the Schwab connection parameters which are required for 
accessing the online features of StreetSmart.    

Passwords and access phone numbers must be entered by the user.    In addition, you may 
need to change them if you move to a different city or access Schwab's computers while 
travelling.    Passwords and access numbers are provided in your StreetSmart starter kit.

Dow Jones Password this password is transmitted automatically when a connection request 
for Dow Jones News or Dow Jones News/Retrieval is made

Info Provider this is the ID and Key of the Scwhab host computer; this information is
the same for users worldwide

CompuServe Phone # the local access phone number for the Compuserve network; 
note that you can specify up to three CompuServe access numbers; 
the currently active CompuServe number is indicated by the radio 
button to the right of the number and you can switch between 
numbers by entering a new number and clicking on the radio button 
beside the new number.    To obtain your local CompuServe number, 
refer to the CompuServe network access number booklet or call 
800/848-8980.

Note that if you have Call Waiting on your modem phone line, 
you must enter a dialing prefix to disable Call Waiting for the 
duration of your connection to Schwab.

Outage Phone # the outage features is used in case of network failure.    If a problem 
occurs accessing the network through a particular node, you can dial 
a different local node or call StreetSmart Customer Service to get 
temporary 800 number access while the CompuServe node is out of 
service

Alternate Network telecommunications carrier (e.g. Tymnet) which is to be used as an 
alternate to CompuServe; you must specify an account number and 
password for accessing this network, as well as the access phone 
number



Enter Order
Once an order has been created but not yet submitted (i.e. is on the Unsubmitted Orders 
screen), you can change it by highlighting the order and selecting the Edit Order button.    
The screen that appears is similar to the Add Order screen.

You can make the desired changes and select OK to return to the previous window.    Note 
that when you return to the Unsubmitted Orders screen, the changes will have been 
incorporated into the order display on the screen.



Schwab Trading Password
This screen appears only once per StreetSmart session--the first time that you make a 
request for one of Schwab's online services.    Type the trading password for your Schwab 
account.    An initial password was provided by Schwab as part of your introductory 
material when you signed up for online access to Schwab through StreetSmart.    After the 
first Schwab access, StreetSmart required you to enter a new password.

If you submit multiple orders or other requests to the Schwab computer during the same StreetSmart session, you 
will not be asked for your password on subsequent requests.

If you have forgotten your password, contact Schwab technical support for assistance.    See
the Technical Support section of the StreetSmart Reference manual for how to reach 
technical support..



Submit Order Confirmation
This screen appears after a connection to the Schwab host computer has been established 
and an order is about to be submitted to the Schwab traders for fulfillment.

If you click on the Place Order button, the order will be submitted and the trade will be placed with Schwab.

At this point, you must choose Skip Order if you wish to terminate the ordering process.        If an error was made in
the order, choosing Change Order allows you to revise the order parameters.

Normally, you would choose Place Order to proceed.    Schwab would then confirm that the order has been 
accepted.



Page Setup
This command primarily allows you to select the page margins for printing the current view.    This dialog also 
allows you to place a title and/or date stamp on each page of the document to be printed.

Margins amount of white space to leave at the edges of 
the paper

General Preferences the text in the Title field will display at the top of
the page; if Date Stamp is enabled, the date will 
also appear at the top of the page



Customize Price History
In StreetSmart, you can display price data on the securities of your choice.    Price history views can be customized 
by selecting the Customize command when a price history view is displayed or by choosing the Edit button from 
the Price History Views window.

You can only customize the price history of one security at a time.    Specify the date range you want the customized 
view to cover, and then indicate the data columns you want to include in the view.
These fields are defined in the Terminology section of the Reference manual.    



Add Category
A category is a group of investments which are defined by the investor to suit their purposes.    For example, some 
investors may define categories by security type such as stock categories, mutual fund categories, bond categories, 
etc.    Other investors may establish categories using industry classifications such as biotechnology, transportation, 
textiles, etc.    The Category setup feature of StreetSmart gives you the flexibility to define as many categories as you
would like, breaking up your securities in whatever manner is most informative and meaningful to you.

This command creates, changes or deletes a category name. Simply click on Add and enter the desired category 
name, for example, Bio-Tech or Growth.

The functions performed by the buttons are:
Add create a new category name
Edit change an existing category name
Delete delete a category name
Close close this window and resume 

other operations

Once the category name has been created,    you can add securities to the category definition from the Securities 
View screen.    Whenever you add a new security or edit an existing security definition, you can select the category 
that security belongs to.



Quick Quotes
This command gets price quotes on a security or group of securities.    It is equivalent to using the Quotes icon.    The
initial screen shows quotes that have already been requested during the current session.    In addition, the buttons 
across the top of the screen allow you to request a quote or display additional data for the currently highlighted 
quote.

Market indicators (DJ Industrial Average, NYSE Volume, tick) on the top right of the screen will be inactive (grayed
out) if the information is not available.

Standard fields are defined in the Terminology section of the Reference manual.
Volume number of shares that have traded as of the opening of today's 

market
Net Change amount that the security's price has increased or decreased as of the 

previous market close
Flags indicators of special situations affecting trading, volatility, price, etc. 

for the requested security; examples of quote flags include security 
split announcements, trading halted, and ex-dividend date



Quick Quotes - More...
The More button displays additional fields that relate to the currently highlighted quote.    If you have requested 
Basic or Extended quotes, you will see different fields.



Customize Transactions View
When a transaction view is displayed on the screen, it can be customized by changing the options on the customize 
screen:

Standard fields are defined in the Terminology section of the Reference manual.    The other field definitions are:
Filter indicate the account(s), securities, types of securities and categories 

to display on the view (other items will be filtered out)
Sort By display items in the order specified; this affects the order in which 

rows are displayed on the screen
Misc Fees any non-commission charges associated with the transaction (e.g. 

transfer fees, dividend reinvestment fees, etc.)
Commission fee charged by a brokerage firm to place security trades
Settlement 
Date

actual settlement of a transaction takes one to five days after the 
execution of a trade; the settlement date can be verified by reviewing
your confirmation notice sent by the broker

Accrued 
Interest

interest on a bond or other fixed income instrument that has 
accumulated since the most recent interest payment was made; when
a security with accrued interest is sold, the buyer pays the seller the 
security's price plus the accrued interest

Description blank field provided for the user to make personal notes about the 
transaction



Customize Securities View
When a securities view is displayed on the screen, it can be customized by changing the options on the customize 
screen.

Standard fields are defined in the Terminology section of the Reference manual.    The other field definitions are:
Filter indicate the account(s), securities, types of securities and 

categories to display on the view (other items will be filtered out)
Sort By display items in the order specified; this affects the order in which 

rows are displayed on the screen
High highest price the security has traded at during the current or most 

recent trading day
Low lowest price the security has traded at during the current or most 

recent trading day
Volume number of shares that have traded as of the opening of today's 

market activity
52 Week High highest price per share that the security has traded at in the past 52

weeks
52 Week Low lowest price per share that the security has traded at in the past 52 

weeks
High Alert notification that a security's per share price has met or risen above 

a level specified by you
Low Alert notification that a security's per share price has reached or fallen 

below a level specified by you
Last Trade security price at which the last trade was executed; after market 

close, this is the closing price
Last Quote 
Update

date when you last received a quote on this security

Quote Source the source that was used to receive your last quote:    Schwab, 
Dow Jones, manual entry, etc.

Retention 
Frequency

number of quotes you want to retain on a specific security; for 
example, specifying everything means that your database will 
retain every quote you request for the security; specifying once 
per week means that only the last quote you request each week 
will be saved

Retention 
Period

length of time you want to retain historical quotes in your 
database; for example, you have the flexibility to save from as 
little as one day of data to all the quote data you have ever 
requested

Retention 
Months

number of months you want to retain the historical quote data you 
have stored in your database; this field is only used if you specify 
Months under the Retention Period field

Expiration 
Date

(options only) option contracts which have expired cannot be 
exercised and no longer have any market value

Maturity Date date on which the final interest payment and face value of a fixed 
income security (i.e. bond or note) is due and payable by the debt 
issuer

Current Yield rate of return an investor can expect to receive on a fixed income 
security (i.e. bond or note) if the security is held until its specified 
maturity date

Dividend dividend distributions (generally representing a percentage of the 
company's earnings)

Taxable Status whether security is taxable in terms of capital gains, dividends or 
interest payments

CUSIP # Committee on Uniform Securities Identification Procedures 



identification number assigned to each security
SIC Standard Industrial Classification (SIC) code assigned to the 

company identifying the company's primary industry; this code 
may be used as a general way of tracking industry performance or 
to compare performance within an industry

Last Split Date date on which a stock last split its shares or paid a stock dividend



Customize Position View
After a position view is displayed on the screen, it can be customized by selecting the Customize icon.    The 
following parameters are available:

Standard fields are defined in the Terminology section of the Reference manual.    The other field definitions are:
As of Specifying 

Now 
for this field requests a customized view as of the current date; 
otherwise, specify the date from which you want the view data to be 
customized.

Filter indicate the account(s), securities, types of securities and categories 
to display on the view (other items not selected will be filtered out)

Subtotal By subtotal amounts or values by symbol, by category, etc.
Sort By display items in the order specified; this affects the order in which 

rows are displayed on the view screen
Show Columns select the columns to be displayed on the view by clicking in the 

checkbox to enable/disable specific columns; the order in which 
columns appear cannot be changed and only the columns being 
displayed can be customized

Date date security was purchased
Commission fee charged by a brokerage firm to place security trades
Total Amount total cost of the transaction calculated as (quantity x item price) + 

misc fees + commission
Current Price security price as of the last time you updated prices for this security
Market Value Quantity x Current Price.    Since current price represents the price 

when you last accessed the Schwab computer, the market value on 
your Position Views screen may not accurately reflect the actual 
market value for trading

Unrealized 
Gain/Loss $

calculation of the dollar value you have gained or lost on a security 
position which is still open; upon selling or closing the security 
position, this gain or loss would become realized rather than a paper 
gain/loss

Unrealized % 
Gain/Loss

calculation of the annualized % return on a security investment for a 
position which is still open; upon selling or closing the security 
position, this gain or loss would become realized rather than a paper 
gain/loss

Unrealized 
Annualized % 
Gain/Loss

Adjusting data calculations such as rate of return and gain/loss so 
that the result is equivalent to looking at a security as though it had 
been held for exactly one or more years

Current Yield actual rate of return on a fixed income security (i.e. bond or note) if 
it were purchased today; this figure generally fluctuates with interest 
rates in the economy and will typically be different from the rate of 
return stated on the security (i.e. nominal rate)

YTD Dividend the sum of all cash dividends paid since the start of the calendar year
YTD Interest the sum of all interest payments you have received since the start of 

the calendar year
Holding Period length of time an asset has been owned by you;    this is most often 

used to determine short-term vs. long-term gains and losses



Add/Edit Transaction
On the Transactions View, values are normally updated by doing a download of transactions.    However this data is
kept by the Schwab host for only 30 days.    If you need to incorporate transactions from a previous time, you can 
enter them manually by choosing the Add button from the Transaction View display.

On this dialog, fill in the field values as defined in the section Customizing Transaction Views in the Reference 
manual.



Stock Split
You cannot download stock split data from the Schwab host computer, so stock splits must be entered manually.

To enter a stock split, fill in the values on this screen.    So for example, if the security had split 2 for 1 with a record 
date of 1/1/93, you would simply enter that data onto this window and click on OK to accept it.




